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Thank you for choosing Epiphan!  
At Epiphan Systems Inc. (“Epiphan”), product function and quality are our top 
priority. We make every effort to exceed our customers’ expectations.  

Product Feedback  

We regularly contact our customers to ensure product performance and 
reliability. We strive to continually enhance our products to meet your needs; we 
welcome your feedback and suggestions for product improvements. Email your 
comments to info@epiphan.com. 

Specifications  

Go to Frame Grabbers on the Epiphan website for more information about 
SDI2USB 3.0.  

Warranty  

All Epiphan Systems products have a 100% return to depot warranty for one year 
from the date of purchase.  

Technical Support  

Epiphan is staffed by a professional support team. If, after checking the FAQs 
for your product on the Epiphan website and re-installing the Epiphan driver 
software (where applicable), you continue to have outstanding issues, email a 
problem report to support@epiphan.com. To help us solve the problem 
efficiently, include the following info:  

• Your SDI2USB 3.0 serial number.  
• Technical description of the signal source including resolution, refresh 

rate, synchronization, type of hardware.  
• Complete description of the problem you are experiencing.  
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Terms and Conditions 
This document, the Epiphan web site, and the information contained therein, 
including but not limited to the text and images as well as Epiphan Systems Inc. 
trademarks, trade names and logos are the property of Epiphan and its 
affiliates and licensors, and are protected from unauthorized copying and 
dissemination by Canadian copyright law, United States copyright law, 
trademark law, international conventions and other intellectual property laws.  
 
Epiphan, Epiphan Systems, Epiphan Systems Inc., and Epiphan logos are 
trademarks or registered trademarks of Epiphan Systems Inc., in certain 
countries. All Epiphan product names and logos are trademarks or registered 
trademarks of Epiphan. All other company and product names and logos may 
be trademarks or registered trademarks of their respective owners in certain 
countries.  
 
Copyright © 2014 Epiphan Systems Inc. All Rights Reserved. 
 
THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE 
ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION 
PACKET OR PRODUCT INSTALLATION SOFTWARE PACKAGE THAT 
SHIPPED WITH THE PRODUCT OR THE PRODUCT DOCUMENTATION AND 
ARE INCORPORATED HEREIN BY REFERENCE.  IF YOU ARE UNABLE TO 
LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT 
YOUR EPIPHAN REPRESENTATIVE FOR A COPY. 
 
IMPORTANT:  BEFORE DOWNLOADING, INSTALLING, OR USING THE 
SOFTWARE AND DOCUMENTATION, PLEASE CAREFULLY READ THE 
AGREEMENT WHICH CONTAINS THE TERMS AND CONDITIONS UNDER 
WHICH YOU ARE ACQUIRING A LICENSE TO USE THE SOFTWARE AND 
DOCUMENTATION. IF YOU DO NOT ACCEPT THE TERMS AND 
CONDITIONS OF THIS AGREEMENT PLEASE DO NOT DOWNLOAD, 
INSTALL, OR USE THE SOFTWARE AND DOCUMENTATION AND 
PROMPTLY RETURN OR DESTROY THE SOFTWARE AND 
DOCUMENTATION. IF YOU DOWNLOAD, INSTALL, OR USE THE 
SOFTWARE AND/OR DOCUMENTATION, YOU WILL HAVE ACCEPTED AND 
AGREED TO THESE TERMS AND CONDITIONS. THE SOFTWARE AND 
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DOCUMENTATION ARE ALSO PROTECTED BY COPYRIGHT LAWS AND 
INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER 
INTELLECTUAL PROPERTY LAWS. IF YOU ARE AN AGENT OR EMPLOYEE 
OF AN ENTITY, YOU REPRESENT AND WARRANT THAT (I) THE 
INDIVIDUAL ACCEPTING THIS AGREEMENT IS DULY AUTHORIZED TO 
ACCEPT THIS AGREEMENT ON SUCH ENTITY’S BEHALF AND TO BIND 
SUCH ENTITY, AND (II) SUCH ENTITY HAS FULL POWER, CORPORATE OR 
OTHERWISE, TO ENTER INTO THIS AGREEMENT AND PERFORM ITS 
OBLIGATIONS UNDER THIS AGREEMENT. 
 
PRODUCT DESCRIPTIONS AND SPECIFICATIONS REGARDING THE 
PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT 
NOTICE. EPIPHAN PERIODICALLY ADDS OR UPDATES THE INFORMATION 
AND DOCUMENTS ON ITS WEB SITE WITHOUT NOTICE. ALL 
STATEMENTS, INFORMATION AND RECOMMENDATIONS ARE BELIEVED 
TO BE ACCURATE AT TIME OF WRITING BUT ARE PRESENTED WITHOUT 
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED.  USERS MUST TAKE 
FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS. 
 
LIMITATION OF LIABILITY 
UNDER NO CIRCUMSTANCES SHALL EPIPHAN BE LIABLE FOR ANY 
INCIDENTAL, SPECIAL, CONSEQUENTIAL, EXEMPLARY OR OTHER 
INDIRECT DAMAGES THAT RESULT FROM THE USE OF, OR THE INABILITY 
TO USE, THIS PRODUCT OR THE INFORMATION CONTAINED ON THIS 
DOCUMENT OR PROVIDED ON EPIPHAN’S WEB SITE, EVEN IF EPIPHAN 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO 
EVENT SHALL EPIPHAN'S TOTAL LIABILITY TO YOU FOR ALL DAMAGES, 
LOSSES, AND CAUSES OF ACTION RESULTING FROM YOUR USE OF THIS 
PRODUCT, WHETHER IN CONTRACT, TORT (INCLUDING, BUT NOT 
LIMITED TO, NEGLIGENCE) OR OTHERWISE, EXCEED THE AMOUNTS YOU 
PAID TO EPIPHAN DURING THE MOST RECENT THREE-MONTH PERIOD IN 
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CONNECTION WITH AMOUNTS WHICH YOU PAID FOR USING THIS 
PRODUCT. 
 
INFORMATION AND DOCUMENTS, INCLUDING PRODUCT 
SPECIFICATIONS, PROVIDED IN THIS DOCUMENT OR THE EPIPHAN WEB 
SITE ARE PROVIDED "AS IS." SPECIFICALLY, BUT WITHOUT LIMITATION, 
EPIPHAN DOES NOT WARRANT THAT: (i) THE INFORMATION IS CORRECT, 
ACCURATE, RELIABLE OR COMPLETE; (ii) THE FUNCTIONS CONTAINED 
ON THE EPIPHAN WEB SITE WILL BE UNINTERRUPTED OR ERROR-FREE; 
(iii) DEFECTS WILL BE CORRECTED, OR (iv) THIS WEB SITE OR THE 
SERVER(S) THAT MAKES IT AVAILABLE ARE FREE OF VIRUSES OR 
OTHER HARMFUL COMPNENTS. EPIPHAN SPECIFICALLY DISCLAIMS ALL 
REPRESENTATIONS, WARRANTIES AND CONDITIONS, EITHER EXPRESS, 
IMPLIED, STATUTORY, BY USAGE OF TRADE OR OTHERWISE INCLUDING 
BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, 
NON-INFRINGEMENT, TITLE, SATISFACTORY QUALITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 
 
For additional terms and conditions, please refer to additional sections in this 
document. 
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1. SDI2USB 3.0 Overview 
SDI2USB 3.0™ Epiphan's newest external frame grabber uses an SDI input 
connection to transmit data to a video capture workstation through a USB 3.0 port or a 
USB 2.0 port. The video capture workstation can capture, record and broadcast 
uncompressed production-quality images and videos directly from 3G-SDI, HD-SDI 
and SD-SDI sources. Both audio and video capture is supported and no peripheral 
component interface (PCI) is required.  
 
SDI2USB 3.0 captures video from an SDI video source. Meeting greater demands for 
transferring larger files at faster speeds, this external frame grabber supports USB 3.0 
technology, capable of transferring  uncompressed data with speeds of up to 5.0 
(Gbits/s) - about ten times faster than USB 2.0. 
Note: In practice, transfer speeds are dependent on factors such as the task and 
hardware configuration. 
 
SDI2USB 3.0 is versatile and can be used with multiple workstation configurations. It 
is backward compatible with USB 2.0 connections, however it transfers compressed 
video with a lower quality when using USB 2.0.  
 
SDI2USB 3.0 supports full HD capture rate of 60 frames per second. All captured data 
is converted to RGB 24-bit color format. When SDI2USB 3.0 is configured to capture 
and transfer video to third-party software, such as Window Media Encoder configured 
for YUV color format, SDI2USB 3.0 converts RGB 24-bit color format to YUV color 
format. When YUV 4:2:0 chroma subsampling is applied, video can be captured and 
recorded up to 60 frames per second. 
 
In addition to an input port, the SDI2USB 3.0 offers an SDI output port that can be 
used for confidence monitoring. In the example below, a monitor connected to the 
output port allows you to monitor the input signal and make quick adjustments if 
required.  
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Figure 1 SDI2USB 3.0 sample configuration including confidence monitoring  

 
  
The SDI2USB 3.0 frame grabber is fully compatible with DirectShow on Windows, 
Video4Linux on Linux, and QuickTime on Mac OS X.  
 
SDI2USB 3.0 is part of Epiphan’s complete line of video and audio signal capture 
products.  For more information about all Epiphan’s video signal capture products, 
refer to Frame Grabbers Overview on Epiphan’s website.  

1.1 Package Contents 
 
Epiphan SDI2USB 3.0 device package includes the following: 
 

1. SDI2USB 3.0 frame grabber 
2. One SDI cable (3G compliant) 
3. USB 3.0 cable 

2 Physical Attributes  

2.1 System Hardware Features 
 
The SDI2USB 3.0 device measures 90mm x 60mm x 23mm (3.54” x 2.36” x 0.91”), 
and features a single input and a single output BNC type connector, a USB 3.0 
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connector and an LED indicator. The SDI2USB 3.0 can be connected to the USB 3.0 
or USB 2.0 port on the video capture workstation.  
 

Figure 2 Front panel of the SDI2USB 3.0 

 
Figure 3 Rear view of the SDI2USB 3.0 
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Connectors and indicators 

Number Interface Status Description 
1 LED The following describes the LED indicators when the 

SDI2USB 3.0 device is connected to a USB 3.0 port: 
Flashing blue: firmware has successfully loaded, device 
is idle. 
Flashing green - video mode detection is in progress.  
 
The following describes the LED indicators when the 
SDI2USB 3.0 device is connected to a USB 2.0 port: 
Flashing green - firmware has successfully loaded, 
device is idle. 
Solid green: video mode detection is in progress. 
 
The following LED indicators apply regardless of the 
USB port type: 
 
Solid red - the frame grabber is powered on, however it 
is not functional. The driver is either not installed or 
failed to load. 
Flashing red - the frame grabber signature validation 
has failed. Possible reasons:  

• On-board EEPROM failure; or 
• Incorrect initialization at the factory. 

In either case the device should be replaced. 
Solid yellow - image capture or data transfer is in 
progress. 
 

2 USB 3.0 Output Connects the SDI2USB 3.0 device to the video capture 
workstation to enable data transfer from the video 
source to the video capture workstation. 
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3 SDI Output Connect an SDI output source, such as a monitor, to the 

SDI2USB 3.0 device. 
Note: the SDI output port is active when the SDI2USB 
3.0 is connected to a powered up video capture 
workstation running the SDI2USB 3.0 driver.  

4 SDI Input Connect an input source with an SD-SDI, HD-SDI or a 
3G-SDI signal. 

  

 

2.2 USB 2.0 Backwards Compatibility 
SDI2USB 3.0 is USB 2.0 backwards-compatible; you can connect it to the USB 2.0 
port in situations when a laptop or workstation has a USB 2.0 port only. It will not 
prevent you from using the frame grabber in these circumstances. SDI2USB 3.0 uses 
green and blue LEDs to indicate whether it is connected to a USB 2.0 or 3.0 port. 
Refer to section System Hardware Features for information on LED indicators.  
 
Configuration Tips: 

• The SDI2USB 3.0 cannot transfer uncompressed video when connected to 
the workstation’s USB 2.0 port. This standard provides lower transfer speed 
than the USB 3.0 standard therefore the frame grabber will compress the 
captured data before transferring. To choose compression options refer to 
Configuring Recording Options. 

 
• The SDI2USB 3.0 must be connected to the USB 3.0 port on the video 

capture workstation when capturing video and audio from an SDI source, 
otherwise only video is captured. For information about configuring a video 
capture workstation to capture video and audio from an SDI source, refer to 
section Windows Capture Application.  

 

2.3 Cables and Connectors 
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High speed data transfer (up to 5 GB/s) is supported by USB 3.0 when you connect 
your SDI2USB 3.0 to the USB 3.0 port on the video capture workstation. 
 
This section describes compatible connectors and cables.  
 

2.3.1 USB AM-BM Cable 

The USB AM-BM cable connects the SDI2USB 3.0 frame grabber to the USB 3.0 or 
2.0 port on the video capture workstation. 
 

Figure 4 USB AM-BM cable 

 
 
 

2.3.2 SDI to SDI Cable 
 
Connects an SDI source to the SDI2USB 3.0 SDI in port. This cable is included with 
the SDI2USB 3.0. 
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Figure 5 SDI to SDI cable 

 

 
 
 

3 System Requirements 
 
Epiphan’s SDI2USB 3.0 frame grabber requires the following hardware and software: 
 

Video source any SDI video source 

Video capture workstation compatible USB 3.0 host controller for 
SuperSpeed operation;  
USB 2.0 controller for High Speed 
operation. 

Processor frequency 2 GHz or faster 32-bit (x86) or 64-bit 
(x64) processor 

RAM memory 2 GB RAM (32-bit and 64-bit) 

Available hard disk space 16 GB available hard disk space (32-bit) 
or 20 GB (64-bit) 

Video capture workstation operating 
system 

Windows XP SP2 or later version;  
Mac OS X 10.8 (Mountain Lion) or later 
version;  
A list of precompiled Linux drivers is 
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available from the Software Download 
page. 

 

3.1 USB 3.0 controllers  
 
To take advantage of the high transfer rate of USB 3.0, ensure your video capture 
workstation is equipped with an adequate USB 3.0 controller capable of supporting the 
transfer rate.  This is especially important when capturing high-definition video and 
large audio files, and capturing 60 fps. Epiphan recommends the following USB 3.0 
controller.   

Linux requirements: kernel version 3.5 or later (Ubuntu 12.10+)  

Recommended high performance controller:  

• Intel ® USB 3.0 eXtensible Host Controller  

4 Getting Started 
 
This chapter describes basic steps for installing drivers and the Epiphan capture 
software, and connecting a SDI2USB 3.0 frame grabber to the video source and the 
video capture workstation. The video capture workstation is a computer that runs the 
drivers and Epiphan capture software and is used to display and record images and 
audio captured by the SDI2USB 3.0 frame grabber. 
 
Basic steps: 
 

1. Review the Package Contents section; verify you received all items. 
2. Review the System Requirements section; verify that your video capture 

workstation will work normally with the frame grabber. The video capture 
workstation can be running Windows, Mac OS, or Linux. 
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3. Install the Epiphan drivers and capture software for the SDI2USB 3.0 on the 

video capture workstation. These procedures are specific to the workstation 
OS and are explained in the following chapters. 

4. Connect the SDI2USB 3.0 to the video source. Refer to Connecting 
SDI2USB 3.0. 

5. Connect the SDI2USB 3.0 to the video capture workstation. Refer to 
Connecting SDI2USB 3.0. 

6. Launch the capture software by clicking on the desktop icon. 
7. Start capturing images.  

 
 
 

5 Installing SDI2USB 3.0 on a video capture 
workstation running Windows  

Follow the step-by step procedures in this section if you are using a Windows PC as 
the video capture workstation to view and record video and audio captured by a 
SDI2USB 3.0 frame grabber. 
 
Note: Install the drivers and capture software on the Windows video capture 
workstation before connecting the frame grabber to the workstation USB port. 

5.1 To install the Windows drivers and capture 
software 

 
1. Find the latest Windows drivers and Epiphan Capture software. Browse to 

http://www.epiphan.com/products/dvi-frame-grabbers/sdi2usb-3-
0/downloads.  

2. Click on the Download tab. The Download page opens. 
3. Scroll down the page to the Windows section. 
4. Select the applicable version of the drivers and capture software that will run 

on the video capture workstation. Note the download destination folder. 
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5. Unzip the downloaded file. Right-click on the .zip file and choose Extract All. 
6. Run the Setup Utility (setup.exe) and follow the prompts to install the 

software. 
7. The Windows drivers and Epiphan Capture Tool is now installed.  

 

5.2 To upgrade to the latest Windows software 
version 

From time to time Epiphan releases new versions of Epiphan capture software 
available from the Epiphan web site. To confirm you have the latest capture software, 
select Check for Updates from the Help menu. 
 
Note: Check for Updates will only recommend an update if Epiphan recommends that 
you install a new version. This will happen if the latest version contains significant bug 
fixes or enhancements. If a new Epiphan Capture Tool version contains only minor 
changes, Check for Updates may not recommend that you install a new version. 
 
You can upgrade the Epiphan software on your Windows video capture workstation by 
uninstalling the previous version. If you have problems upgrading the Windows 
version of the software, see the detailed driver update instructions and install/uninstall 
instructions available at 
http://www.epiphan.com/downloads. 

 

5.3 Finding Software Updates 
 
To find the latest versions of all Epiphan software for Windows go to 
http://www.epiphan.com/downloads. You can also browse to the download page for 
your SDI2USB 3.0 product - browse to http://www.epiphan.com and select Products > 
Frame Grabbers > SDI2USB 3.0. On these pages you will find the most recent 
versions of: 
• Epiphan SDI2USB 3.0 User Guide. 
• Epiphan USB device driver and Epiphan Capture Tool for Windows. 
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5.4 Troubleshooting a Windows Installation 
If you experience any difficulty viewing captured images with the Windows capture 
application, review the following items prior to contacting technical support. 
 
If the capture application cannot find the frame grabber: 

• Confirm that the frame grabber is connected to a video capture workstation 
USB port and has power connected and the device LEDs are lit. 

• Disconnect and re-connect the frame grabber. This prompts Windows to 
install the device drivers for the frame grabber if they haven’t already been 
installed. 

• Observe the behaviour of the frame grabber LED indicators. 
• Check the Windows Device Manager to verify that the frame grabber has 

installed successfully and that the PC supports USB 3.0.  
 
If, after following the installation steps, you are still experiencing problems, close all 
applications and restart the video capture workstation. When the video capture 
workstation has started up, open the Windows Device Manager to confirm that the 
frame grabber is detected. 
 

 

6 Mac OS X Video Capture Workstation 
Installation 

Follow the step-by step procedures in this section if you are going to use a Mac as a 
video capture workstation to view and record images captured by the frame grabber. 

6.1 To Install the Mac Drivers and Application 
A single download from the Epiphan web site includes the capture application 
command line capture application (v2u), the SDI2USB 3.0 system preferences and the 
QuickTime digitizer (vdig). 
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1. Find the latest Mac drivers and application software. Browse to  

http://www.epiphan.com/products/dvi-frame-grabbers/sdi2usb-3-
0/downloads/ and scroll down to the Mac section of the download page. 

2. Download the latest version of the drivers and application that will run on the 
video capture workstation. Make sure you note the download destination 
folder. 

3. Double-click on the .dmg file to unpack it if it does not unpack automatically. 
4. Double-click on the .pkg file and follow the prompts. 

Note: The final step of the installation requires restarting the video capture 
workstation. 

 
To install the SDI2USB 3.0 in the video capture workstation, refer to the section 
Connecting SDI2USB 3.0. 

6.2 To Start the Mac OS Capture Application 
On the video capture workstation, run the capture application, from the Applications 
folder, select SDI2USB.app. The capture application starts up. If the SDI2USB 3.0 
frame grabber is connected and powered on, the capture application should 
automatically find the frame grabber and begin displaying captured images. If the 
frame grabber is operating but not capturing images the device name and serial 
number should appear in the title bar and the capture application displays No signal 
detected. 

6.3 Upgrading to the Latest Mac OS X Software 
Version  

From time to time Epiphan releases new versions of all Epiphan frame grabber 
software available from the Epiphan web site. In most cases you can upgrade the 
Epiphan software on your Mac OS X video capture workstation by using normal 
procedures to download the latest version and install it without uninstalling the 
previous version.  
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Linux Video Capture Workstation Software  
Note: Some versions of the SDI2USB 3.0 user interface do not install a shortcut on the 
Mac OS X desktop. You can drag the Epiphan icon from the Applications folder to 
your desktop or add it to the Dock after installing a new version of the SDI2USB 3.0 
user interface. You may also need to delete older versions of the Epiphan icon.  

6.4 Finding Software Updates  

To find the latest versions of all Epiphan software and drivers for Mac OS X, browse to 
http://www.epiphan.com/products/dvi-frame-grabbers/sdi2usb-3-0/downloads/. 

On this download page you will find the most recent release of the Epiphan device 
driver, QuickTime component and SDI2USB 3.0 application compatible with Mac OS 
X.  
 

7    Linux Video Capture Workstation Software 
 
Epiphan provides the Epiphan USB device driver and the Epiphan capture API for 
Linux. Epiphan does not provide a video capture application for Linux. However, the 
USB device driver is compatible with Video4Linux so you can use Video4Linux 
compatible applications to receive and process captured images. You can also use 
the Epiphan Linux SDK to write your own custom video capture application that 
receives captured images from the Epiphan capture API. The following software 
components operate on a video capture workstation running Linux: 
 
• The Epiphan USB device driver 
• Video4Linux 
• The Epiphan capture API 
• V4L custom video capture applications 
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7.1 The Epiphan USB Device Driver 
The Linux Epiphan USB device driver receives images from an Epiphan SDI2USB 3.0 
and delivers the images to the Epiphan capture API and to Video4Linux. Before 
delivering the images the Epiphan USB device driver also performs image adjustment 
to improve the quality of the image. Image adjustments include setting the sampling 
phase, PLL adjustments, and horizontal shift. The USB device driver can also change 
the color depth of the captured image before sending the image to the video API. For 
example, if the SDI2USB 3.0 is capturing the frames at a color depth that is different 
than that required by the video capture application, the USB device driver converts the 
images to the required color depth. 
 
The Epiphan USB device driver may not be available for your version of Linux. 
Epiphan does not provide source code for the Epiphan USB device driver. But you can 
contact Epiphan if you need an Epiphan USB device driver compiled for a specific 
Linux kernel version or kernel setting. Using the Epiphan software development kit 
(SDK) you can also create custom USB device drivers that incorporate the functions 
you need. 
 

7.2 Video4Linux 
Video4Linux (V4L) is a Linux video capture API. The Epiphan USB device driver can 
send captured images directly to Video4Linux. This means that any Video4Linux-
compatible application can receive captured images. You can use a Video4Linux-
compatible application to record a series of captured images as a video in the video 
format supported by the Video4Linux application. You can also create your own 
custom Video4Linux-compatible video capture application to record captured images 
from Video4Linux. 
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7.3 The Epiphan Capture API 
The Epiphan capture API also receives captured images from the Epiphan USB 
device driver. The Epiphan capture API is optimized for processing Epiphan SDI2USB 
3.0 captured images. The Epiphan capture API analyzes individual images, 
performs on-device cropping, and handles video mode changes. The Epiphan capture 
API is an alternative to using Video4Linux to capture images on Linux video capture 
workstations. You can use the Epiphan software development kit (SDK) to create  
custom video capture applications to record captured images from the Epiphan 
capture API. 
 

7.4 V4L Custom Video Capture Applications 
Epiphan does not provide a video capture application for Linux. However, you can use 
Video4Linux-compatible applications to perform many video capture operations such 
as recording images or video, copying, printing and saving images, or broadcasting 
images over the Internet. You can also use the Epiphan Linux SDK to create your own 
custom video capture application. The SDK along with some example applications is 
available from the products Downloads page (http://www.epiphan.com/products/dvi-
frame-grabbers/dvi2usb-3-0/downloads/). 

8 Connecting SDI2USB 3.0  
This section describes how to connect an SDI source and video capture workstation to 
the SDI2USB 3.0. Ensure the Epiphan capture software is installed on the video 
capture workstation before connecting the SDI2USB 3.0. 
 
1. Connect the  SDI2USB 3.0 to the video source.  
2. Connect an SDI source directly to the IN port on the SDI2USB 3.0 using the SDI 

cable included in the package. 
3. Optionally, connect an external monitor, for confidence monitoring, to the OUT 

port on the SDI2USB 3.0 using a standard SDI cable.   
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4. Connect the SDI2USB 3.0 to the video capture workstation by connecting the 

USB AM-BM cable from the SDI2USB 3.0 to the workstation’s USB 3.0 or 2.0 
port. 

If you installed the drivers and Epiphan Capture Tool software, the video capture 
workstation should automatically recognize the SDI2USB 3.0 and install drivers for it. 
 
Note: You can use a high-quality SDI splitter to split the SDI signal between an 
external monitor and the frame grabber, or you can connect an external monitor 
directly to the SDI out port located on the SDI2USB 3.0 device for confidence 
monitoring. The SDI out port is a practical way to simultaneously display the video to a 
remote monitor while it is captured, recorded and streamed.  
 

9 Windows Capture Application 

This chapter describes common functions and features of the Epiphan Capture Tool. It 
supports the Windows XP, Vista, 7 and 8 versions. This chapter assumes that you 
have followed the installation and connection instructions described above. Before you 
get started make sure you have:  

• video signal source 
• video capture workstation running Windows; connected to a SDI2USB 3.0.  
• SDI2USB 3.0 drivers and Epiphan Capture Tool installed on the video 

capture workstation. 

9.1 Start the Windows Capture Application  

To start the application, from the Windows Start menu select Start > Epiphan Capture 
Tool. The application starts up and looks for the SDI2USB 3.0 frame grabber 
connected to your PC.  

If the SDI2USB 3.0 is operating, the capture application should find it and the image 
captured by the SDI2USB 3.0 should appear on the application display.  
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If the SDI2USB 3.0 device is not capturing images, the application window displays No 
signal.  

As the application starts, the following messages may appear:  

• Capture device not found as the application attempts to connect with the 
SDI2USB 3.0 device.  

• Detecting Video Mode as the application connects to a device and then 
determines the video mode of the device. 

• Tuning Capture Parameters as the application synchronizes and tunes 
capture settings and image adjustments. 

• No Signal Detected when the application is connected to an SDI2USB 3.0 
that is not connected to an active video source. 

If the application successfully connects to and synchronizes with the SDI2USB 3.0 
device, it begins displaying captured images.   

9.2 Record captured images as image files  
Before recording captured images as a series of image files, you must first configure 
the recording options.  
1. Select Options from the Tools menu.  
2. Select the Recording tab. 
3. Select Record as Images. You can also select the image file format, location to 

save images and other image file settings from this window. 

9.2.1 To start a recording 

1. Perform one of the following: 
a) Select Start Recording from the Capture menu; 

b) Select the Record icon   from the toolbar; or  
c) Use the key combination CTRL+R. 

Images are captured by the frame grabber and recorded as a series of image files. 
The Status bar displays the name and location of the last saved file.  
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9.2.2 To pause a recording 

1. Perform one of the following: 
a) Select Pause from the Capture menu; 

b) Select the Pause icon from the toolbar; or  
c) Use the key combination CTRL+U. 

9.2.3 To stop a recording 

1. Perform one of the following: 
a) Select Stop Recording from the Capture menu; or 

b) Select the Stop icon from the toolbar. 
When you stop recording images, the status bar displays the number of image files 
saved.  

9.3 Record captured images as video 
Before recording captured images as a video, you must first configure the recording 
options on the Epiphan Capture Tool.  
1. Select Options from the Tools menu.  
2. Select the Recording tab. 
3. Select the arrow next to Record as field. A dropdown menu appears. 
4. Select Video. Configure other options as required. 
5. Click Apply. 

9.3.1 To capture video and audio from an SDI source 

SDI2USB 3.0 supports audio recording when SDI2USB 3.0 is connected to the USB 
3.0 port. 
 
Configure audio input on the video capture workstation 
1. From the Windows toolbar, right-click on the volume icon. A dropdown menu 

appears. 

 
21 SDI2USB 3.0  User Guide 
 



Windows Capture Application  
2. Select Recording devices. A Sound window opens with the Recording tab 

displayed. 
3. Choose one of the following: 

a) Select SDI In to capture system audio; or 
b) Select Microphone to capture audio from a built-in microphone. 

4. Click on the Set Default button. 
5. Click OK. The sound window closes. 
6. From the capture software select Audio Input Device from the Capture menu. A 

list of audio devices appears. 
7. Choose one of the following: 

a) Select Default Windows Device to capture system audio (SDI In). 
b) Select microphone to capture audio from a built-in microphone. 

8. From the toolbar ensure the audio icon  is enabled. 

9.3.2 To start a recording 

1. Perform one of the following: 
a) Select Start Recording from the Capture menu; 

b) Select the Record icon   from the toolbar; or  
c) Use the key combination CTRL+R. 

2. A Save as dialog box appears, enter the file name and select the location for 
saving the video file,  

3. Click Save. The capture tool begins to record the source video. 

As images are captured by the frame grabber they are recorded to the video file. The 
status bar displays the name and location of the video file, the elapsed recording time 
and the number of frames (or images) recorded.  

When video file reaches the AVI file size limit one of the following occurs based on 
recording configuration settings:  

• recording stops; 
• recording continues and a new video file is created; or 
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• recording continues and the original video file is overwritten. 

To set recording options refer to Configuring Recording Options. 

9.3.3 To pause a recording 

1. Perform one of the following: 
a) Select Pause from the Capture menu; 

b) Select the Pause icon from the toolbar; or  
c) Use the key combination CTRL+U. 

9.3.4 To stop a recording 

1. Perform one of the following: 
a) Select Stop Recording from the Capture menu; or 

b) Select the Stop icon from the toolbar. 
When you stop recording, the status bar displays the name and location of the saved 
video file, number of frames recorded, and elapsed recording time. For example: 
Wrote c:\temp\example.avi (85 sec, 464 frames). 

9.4 Pausing, Copying, Saving, and Printing Images 

Once the application is displaying images captured by the frame grabber, you can 
pause, copy, save, and print the current image.  

9.4.1 To pause and resume the image capture  

1. Select Pause Capture from the Capture menu or from the toolbar select . 
2. While image capture is paused, the application stops receiving new images 

from the device. Pause also pauses video recording, and image recording. 
While paused, you can save, print, and copy the captured image.  

3. To resume image capture select Resume Capture from the Capture menu or 

from the toolbar select . You can use the following procedure to copy the 
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image currently displayed by the application to the video capture workstation 
clipboard.  

9.4.2 To copy a snapshot of the current image  

1. Select Copy from the Edit menu or select  from the toolbar. You can also 
use the key combination CTRL+C. The current image is copied to the 
clipboard.  

2. Paste the image into a document or other application as a bitmap image. The 
image is pasted as a device independent bitmap image.  

9.4.3 To save a snapshot of the current image as an image file 

You can use the following procedure to save the current image as a .bmp, .png, or .jpg 
file on the video capture workstation. You can optionally pause the image capture 
before saving the image.  

1. Select Save from the File menu or from the toolbar select  or use the 
key combination CTRL+S. The status bar shows the location and name of 
the saved file.  

2. The first time you save an image, the Save As dialog appears and you can 
specify the file name, file type, and location of the saved image file.  

3. When you select Save again, the application saves the new image with the 
same file name and location, overwriting the previously saved file. You can 
select Save As to save the image with a different file name, file type, or 
location or use the key combination CTRL+Shift+S.  

4. You can open the saved image file with a bitmap image editing application.  

9.4.4 To print a snapshot of the current image  

Use the following procedure to print the current image on any printer that is connected 
to the video capture workstation. You can optionally pause the image capture before 
printing the image.  
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1. Select Print from the File menu, select  from the toolbar or use the key 
combination CTRL+P. The current image is sent to the default printer. You 
can select Print Setup from the file menu or use the key combination 
CTRL+Shift+P to select a different printer and set printer options.  

Note: You can also configure the application to invert colors for printing. From the 
Tools menu select Options, then select the Display tab and select Invert colors for 
printing.  By reversing or inverting the colors of an image, the colors are made 
complementary of the original value. After performing picture color inversion, black 
becomes white, yellow becomes blue, red becomes aqua. 

9.5 Menus  

This section describes the commands available from the following Windows DSI2USB 
3.0 user interface menus:  

9.5.1 File Menu 

Use the File menu commands to save and print the current image displayed by the 
SDI2USB 3.0 user interface and to exit the SDI2USB 3.0 user interface. 

Save Save a snapshot of the current image to a file on the video capture 
workstation. Select a location for the file and select a file format. You 
can save the snapshot as a bitmap (*.bmp), portable network graphics 
(*.png), or JPEG (*.jpg) file.  
The first time you select Save after starting the SDI2USB 3.0 user 
interface, you are prompted for a file name and you can change the file 
location and format. After saving the first file, every time you select 
Save, the video capture software saves a snapshot using the same file 
name in the same location replacing the previously saved file. When 
you select Save, the status bar shows the location and name of the 
saved file.  

Save As Save a snapshot of the current image to a file on the video capture 
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workstation. Using Save As you can enter a file name and select a file 
location and format.  
Save As resets the file name, location, and file format used by the 
Save command and the Save snapshot toolbar button. When you 
select Save As the status bar shows the location and name of the 
saved file.  

Print Setup Configure printer settings used when you select the Print command or 
the Print snapshot toolbar button. You can also configure the 
SDI2USB 3.0 user interface to invert colors for printing. By reversing or 
inverting the colors of an image, the colors are made complementary 
of the original value. After performing picture color inversion, black 
becomes white, yellow becomes blue, red becomes aqua. From the 
Tools menu select Options, then select the Display tab and select 
Invert colors for printing. 

Print Print a snapshot of the current image using the configured printer. 

Exit Close the SDI2USB 3.0 user interface. 

9.5.2 Edit Menu  

From the Edit menu you can copy a snapshot of the current image. You can also use 
the key combination CTRL+C. 

Copy Copy a snapshot of the current image to 
the video capture workstation clipboard. 
You can paste this image into a 
document or other application as a 
bitmap image. 

9.5.3 View Menu  

Use the commands on the View menu to control the parts of the SDI2USB 3.0 user 
interface window that are displayed.  
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Toolbar Change the size of the toolbar icons or hide the toolbar. You can 

select small, large, or huge icons. If the toolbar is hidden, select an 
icon size to display the toolbar. 

Status Bar Enable or disable displaying the status bar. 

Full Screen Enable full screen mode, Ctrl+F. 

Image Only Change the SDI2USB 3.0 user interface to operate in the Image 
only mode. In the Image only mode the SDI2USB 3.0 user 
interface displays the captured image only. The window borders, 
toolbar, status bar and menu bar are not displayed. Scroll bars are 
displayed if required.  
The Image only mode can be useful for applications such as 
integrating the SDI2USB 3.0 user interface into a custom system. 
You can still use all of the shortcut keys to save and print images, 
start and stop recordings, and to exit from the image-only mode. 
You can always press Alt+F4 to exit from the SDI2USB 3.0 user 
interface.  
You can also use the --borderless command line option to start the 
SDI2USB 3.0 user interface in image only mode.  

9.5.4 Capture Menu  

Use the commands on the capture menu to start, stop or pause the capturing and 
recording of images. From the capture menu you can also select the device that the 
SDI2USB 3.0 user interface receives captured images from if you have more than one 
SDI2USB 3.0 or other Epiphan frame grabbers connected to the network. You can 
also view image adjustment settings and VGA mode settings for the selected device.  

The record functions on the capture menu record the current image as a video or as a 
series of consecutive image files. Select Options from the Tools menu and use the 
settings on the Recording tab to configure what the SDI2USB 3.0 user interface 
records. 

Start recording Start recording the current image to a video file or a series of 

 
27 SDI2USB 3.0  User Guide 
 



Windows Capture Application  
image files. 

Pause capture Pause or resume image capturing. If you select pause, the 
SDI2USB 3.0 user interface stops displaying newly captured 
images and the image captured when you selected Pause is 
displayed. Pause also pauses the recording of a video and the 
saving of image files. Select pause again to resume the displaying 
of captured images and to resume recording. 

Select device You can use Select Device or the key combination Ctrl+D to 
choose the device that the SDI2USB 3.0 user interface receives 
captured images from. The command finds and lists available 
SDI2USB 3.0 devices. The list displays the serial number, device 
type, captured image resolution and frequency or status and 
location of each device. You can also use this command to select 
the device to configure with the Configure Device command.  

Connect 
network device 

Connect a device recognized on the network. 

Disconnect 
network device 

Disconnect current device. 

Recent network 
devices 

Displays a list of recently viewed devices. 

Enable audio 
capture 

When enabled, captured audio is played on the video capture 

workstation and can be recorded. The toolbar icon  indicates 
enabled. When disabled, captured audio is not played on the video 

capture workstation and is not recorded. The toolbar icon  
indicates disabled. 

Audio input 
device 

From the dropdown menu select the audio source device. For 
example if you are capturing audio from a built-in microphone, 
choose microphone. If you are capturing video and audio from an 
SDI source, select SDI In or Default Windows device, if you set 
SDI In as the Windows default. 

Play captured 
audio 

When enabled, captured audio is played on the video capture 
workstation and is recorded. When disabled, audio is not played on 
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the video capture workstation, however it is recorded. Use this 
setting to choose whether or not to play the audio while capturing. 

Enable audio capture must be enabled for the Play captured audio 
settings to take effect. 

Configure 
device 

You can view image adjustments for the selected device. You can 
configure image adjustments from the Web admin interface or from 
the Network Discovery Utility.  
You can also select and configure VGA modes for the selected 
device.  
See the following section for more information regarding this 
function. 

  

9.5.5 Configure Device 

This window allows you to perform various image adjustments and select a required 
VGA mode. The following section illustrates and describes what can be configured 
using which tab. 
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Adjustments tab: 
Figure 6 Adjustments tab 

 

 
Horizontal shift Configure horizontal shift to offset the captured image 

position. For example, a captured image shifted slightly 
to the right (horizontally) can be corrected with minor 
adjustments to the horizontal shift settings.  
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Increasing or decreasing the value entered in the 
Horizontal Shift field shifts the image to the right or left. 

Vertical shift Configure vertical shift to offset the captured image 
position. For example, a captured image shifted slightly 
downward (vertically) can be corrected with minor 
adjustments to the vertical shift settings.  

Increasing or decreasing the value entered in the 
Vertical Shift field shifts the image up or down. 

Set offset/gain 
(brightness/contrast)  
 

The offset and gain settings control the image 
brightness and contrast respectively. Increasing the 
offset control causes the image to become darker. 
Increasing the Gain control gives the image more 
contrast. 

Sampling phase This setting adjusts the vertical synchronization 
properties of the image. You may need to change it 
when there is a repetitive distortion or blurriness on the 
horizontal axis of the image. Adjust the setting in small 
steps until a sharper image is displayed.   

PLL adjustment This setting is used to squeeze or stretch the image 
horizontally. 

Prefer wide VGA mode  
 

This checkbox, when enabled, allows Wide Aspect Ratio 
VGA modes to be displayed by the video capture 
application window. The Epiphan USB device driver 
may not be able to determine whether the video source 
is sending a wide video mode signal. You can select this 
option if your video source uses a wide video mode to 
make sure that the Epiphan USB device driver selects a 
wide video mode. 

YCrCb capture Select this checkbox to capture video with YCrCb 
encoding. 
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Note: During capture SDI2USB 3.0 converts 30-bit YUV 
4:2:2 color format to 24-bit RGB. 

 

DirectShow tab: 

Figure 7 DirectShow tab 

 

 
Fix resolution Resolution that is reported to DirectShow. 
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Default image Image sent to DirectShow if there is no 

signal. 

Scale image to match stream resolution Use the slider to scale the image. 

Flip image vertically Select the checkbox to flip the image. 

Limit frame rate to  Specify the frame rate limit. 

Fix frame rate Select the checkbox to fix frame rate. 
 
 

Figure 8 Advanced tab 

 
 

Auto- Specify the interval value.  
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adjustment 
interval 

On-board 
compression 

Select this checkbox to enable on-board compression of the 
incoming signal. 

Digital mode 
detection 

- Automatic 
- Single Link 
- Dual Link 

Sync level 
adjustment 

Adjust sync level (HSync and VSync). 

 

  

9.5.6 Tools Menu  

Use the Tools menu to customize basic SDI2USB 3.0 user interface operating 
settings. 

Figure 9 Tools menu 

 
 
Web Broadcasting Use this command to stream the captured signal, refer to 

Chapter 5, Web Broadcasting, for more details.  

Upload EDID to device Use this command to upload an extended display 
identification data (EDID) file to your device.  

Extended display identification data (EDID) is a data 
structure provided by a digital display to describe its 
capabilities to a video source. It is what enables a modern 
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personal computer to know what kinds of monitors are 
connected to it. EDID is defined by a standard published 
by the Video Electronics Standards Association (VESA).  

Read EDID from device Use this command to read an extended display 
identification data (EDID) file from the device. 

Measure VGA Mode When requested by Epiphan technical support, you can 
use this command to display low-level information about 
the VGA mode that you are capturing with your frame 
grabber. You can copy this information into an email to 
send it to Epiphan technical support. 

Options Configure video recording and display settings.  See the 
section, Capture, Record, and Display Options for more 
information. 

Upgrade Grabber 
Firmware 

Select this option to download the latest FPGA program.  

9.5.7 Help Menu  

Use the Help menu to check for updates and to display information about the version 
of the SDI2USB 3.0 user interface that you are running.  

Figure 10 Help Menu 

 

Note: Check for Updates function will only recommend an update if Epiphan 
recommends that you install a new version. This will happen when the latest version 
contains significant bug fixes or enhancements. If a new SDI2USB 3.0 user interface 
version only contains minor changes or if you are running the current version, Check 
for Updates may not recommend that you install a new version and will not display any 
information.  
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9.6 Toolbar  

The toolbar can be used to save, print, or copy the current captured image; to start, 
pause, and stop the recording of the currently captured image. You can use the 
Toolbar command on the View menu to change the size of the toolbar icons or to hide 
the toolbar. You can select small, large, or huge icons. If the toolbar is hidden, you can 
select an icon size to display the toolbar.  

Figure 11 Toolbar 

 

 

Save a snapshot of the current image captured by the SDI2USB 3.0 user 
interface to a file on the video capture workstation. Select a location for the 
file and select a file format. You can save the snapshot as a Windows 
bitmap (*.bmp), portable network graphics (*.png), or JPEG (*.jpg) file. 

 

Print a snapshot of the current image to the configured printer. 

 

Copy a snapshot of the current image to the video capture workstation’s 
clipboard. You can paste this image into a document or other application as 
a bitmap image. 

 

Start or stop recording the images captured by the SDI2USB 3.0. When you 
start recording, the status bar displays RECORDING and also displays 
information about the image or video file being recorded. When you stop 
recording, the status bar displays information about the saved image files or 
video file. 

 

Pause or resume image capturing. If you select pause, the SDI2USB 3.0 
user interface stops displaying captured images. Pause also pauses the 
recording of a video and the saving of image files. Select pause again to 
resume the displaying of captured images and to resume the recording of a 
video. 
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Enable web broadcasting of the captured signal. Refer to Chapter 5, Web 
Broadcasting, for details. 

 

9.7 Status Bar 
 
The status bar is located at the bottom of the user interface window. 
 

Figure 12 Status Bar indicates status of the SDI2USB 3.0 

 
 
The status bar displays information about the SDI2USB 3.0 user interface: 

• The location and file name of image or video files saved while recording.  
• Recording status. “RECORDING” means that the SDI2USB 3.0 user 

interface is recording captured images.  
• The data rate is the rate (in MB/s, KB/s, Mbps, and Kbps) that the SDI2USB 

3.0 user interface is receiving data from the device capturing images. 
• The frame rate that the SDI2USB 3.0 user interface is operating at in frames 

per second (fps).  
• The number of frames or images that the SDI2USB 3.0 user interface has 

displayed since the SDI2USB 3.0 user interface was last started. The number 
of frames is only visible if you select Number of captured frames on the 
status bar from the Display tab of the Options dialog. The number of frames 
stops incrementing and starts flashing if you have paused the image capture. 
Use the Reset counter button to reset the number of frames from the Display 
tab of the Options dialog. 

• The VGA mode and refresh rate of the video source. 
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9.8 Capture, Record, and Display Options  

This section introduces the options available from the Tools menu when you select the 
Options command. These options control how the SDI2USB 3.0 user interface records 
images, displays images. Note that this application is common to a number of different 
products. The KVM tab functionalities do not apply to the SDI2USB 3.0 product. 

Figure 13 Options window 

 

9.8.1 Configuring Recording Options 

To control how the SDI2USB 3.0 user interface records captured images, select 
Options from the Tools menu and then select the Recording tab. You can record 
captured images as a series of consecutively saved graphic files or as a video file. 
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How the SDI2USB 3.0 user interface records images when you start recording from 
the Toolbar or the capture menu depends on how you set the recording options. 
 
On this tab you can select a codec which is used to encode the captured video 
stream. Codecs are not included in the software package provided by Epiphan for the 
SDI2USB 3.0 frame grabber. You must download them before using the frame 
grabber. For example, you can download an x264 codec pack - a free library for 
encoding H.264/MPEG-4 AVC video streams. 
 
If your computer is running under the 32-bit OS, download a 32-bit codecs pack. For 
the 64-bit OS, download a 64-bit codecs pack. 
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Figure 14 Recording tab 

 
 
You can select the following options: 

Record as Specify whether video or images are recorded. 

Select Codec… Select the codec that is applied for compressing 
the signal. Click on the Select Codec button; a 
Video Compression window opens. Select the 
type of compression and quality applied to the 
recording,  
Choose how often a key frame (a frame that 
contains all the pixels) is used when recording 
and streaming the video. The longer the key 
frame interval the smaller the video  
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file size, and vice versa. 
Configure the Data Rate to set transmission 
speed, the lower the transmission speed the 
lower the bandwidth and system resource usage 
and vice versa. 

AVI file size limit Specify the size limit of the .AVI file where the 
data is recorded. 

Automatically restart recording Select the checkbox to restart recording 
automatically. This checkbox enables the five 
fields below. 

Overwrite the same file (old 
content will be lost) 

After the video file size limit is reached, delete 
the original file and start recording a new video 
file with the same name. If you select this option 
the original saved video data is lost. 

Create a new file every time 
recording is restarted 

After the video file size limit is reached, start a 
new video file. You can use the append suffix 
setting to create a unique name for the new file 
or files. 

Append suffix…  When you start a video recording session you 
are prompted to enter a file name. If the file 
exceeds the AVI file size limit, the SDI2USB 3.0 
user interface starts another file named with the 
original file name appended with a sequential 
numeric suffix. Use the append suffix options to 
specify the format of this suffix.  
 
Each suffix starts with a % sign and can include 
the following characters:  
02, 04, 06, or 08 indicates the number of digits to 
use in numbering the suffix. You can specify 2, 4, 
6, or 8 digits. 
“d” means decimal numbers are used in the 
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suffix. 
“X” means hexadecimal numbers are used in the 
suffix. 
The suffix %02d means the saved file names end 
with two-digit decimal numbers, for example: 01, 
02, 03, ..., 10, 11 and so on. The suffix %04X 
means the saved file names end with 4-digit 
hexadecimal numbers, for example: 0001, 0002, 
0003, ..., 000A, 000B and so on. 

…starting with Enter the starting number used in the file name 
suffixes in decimal format. If the suffixes include 
hexadecimal numbering this decimal number is 
automatically converted to hexadecimal.  
 
For example, if you named the video file VID, set 
the suffix to %02d and set starting with to 1, the 
video file names would be VID.avi, VID01.avi, 
VID02.avi, etc. 

Overwrite existing files If you select overwrite existing files, files are 
saved according to the video file recording 
options. Existing files are replaced with the new 
files.  
 
If you do not select overwrite existing files, the 
file number in the suffix of the file name is 
incremented until a file can be saved without 
overwriting an already saved file. 

Automatically turn recording off Specify under what conditions recording turns off 
automatically. 

After … frames have been saved Enter a number of frames that can be saved 
before recording is automatically stopped. 

After … elapsed Enter the number of milliseconds, seconds, 
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minutes or hours to elapse before recording is 
automatically stopped. 

 

9.8.2 Configuring Display Options 

To change display options from the Tools menu, select Options and then select the 
Display tab.  
 

Figure 15 Display tab 
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The following display options are available: 

Display format Specify in which color format the video or 
image is displayed. 
Note: When SDI2USB 3.0 is configured to 
transfer video to third-party software, such 
as Window Media Encoder configured for 
YUV color encoding, SDI2USB 3.0 converts 
RGB 24-bit color format to YUV color 
format.  
The following lists possible expectations 
when color space conversion is used: 

• When YUV 4:2:0 chroma 
subsampling is applied, video can 
be streamed and recorded up to 
60 frames per second.  

• When YUV 4:2:2 chroma 
subsampling is applied, video can 
be streamed and recorded up to 
45 frames per second. 

• When chroma subsampling is not 
applied, video can be streamed 
and recorded up to 30 frames per 
second. 

Image scaling Specify whether the image should be 
scaled and how it should be scaled. 

Image rotation Specify whether the image should be 
rotated and how it should be rotated. 

Resize window on resolution change Select the checkbox to resize window when 
the image resolution is changed. 

Invert colors for printing Select the checkbox to change dark colors 
to light colors and light colors to dark colors. 

Flip image vertically Flip the image at its vertical axis. 
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Select the check boxes below to add optional indicators to the status bar… 

Frame rate Displays frame rate 

Crop rectangle Displays crop status 

Audio format 48000Hz, stereo, SDI2USB 3.0 supports 16 
bit format. 

Number of captured frames Displays number of captured frames 

Data rate (network grabbers only) Displays data rate 
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9.8.3 Configuring Capture Options 

Open this tab to configure multiple capture options.  

Figure 16 Options tab 

 
 
 
 
Enable hardware cropping Select this checkbox to enable cropping 

functionality. 

Left, Top, Width, Height Enter the values for the crop rectangle. 
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Force video mode detection Specify how often the application indicates 

the type of  video signal that is received. 
Note: increasing the frequency of video 
mode detection to reduce reaction time 
when changing video mode, may also 
reduce the frame rate. 

Automatically reconnect network 
grabbers 

Select this checkbox to restore connection 
with remote frame grabbers when the 
connection is lost. Otherwise the system 
connects to the local frame grabber, if one 
exists or displays a warning “No frame 
grabbers found”. In this case you need to 
restore connection manually. 

Limit frame rate to Specify the maximum frame rate for the 
video signal. 
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9.8.4 Setting On-Screen Text Parameters 

Open the On-Screen Text tab, to timestamp the captured video and add static text. 
This text is displayed on your video output. 

Figure 17 On-Screen Text tab 

 
 
 
Timestamp Select this checkbox to set timestamp parameters. 

Format Specify the timestamp format. 

Color Set the color for the timestamp. 

Outline Add an outline to the timestamp. Use an outline to highlight the 
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timestamp when the text color is similar to the display background 
color. 

Font Click the …button to set the font and the font size. 

Position Set the location on the screen where the timestamp is displayed.  

Static text Select this checkbox to set static text parameters. 

Format Specify the static text format. 

Color Set the color for the static text. 

Outline Add an outline to the static text. Use an outline to highlight the text 
when the text color is similar to the display background color. 

Font Click the …button to set the font and the font size. 

Position Set the location on the screen where the static text is displayed.  
 

9.8.5 Configure Startup 

Open Startup tab to specify what actions the application should perform during 
startup. 
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Figure 18 Startup tab 

 
 
 
Start in full screen mode When the application starts, it resizes to 

the current resolution of the screen. 

Search for network grabber at startup The application will search for network 
grabbers on your subnet when it does not 
find local frame grabbers. 
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9.8.6 Sharing 

Open the Sharing tab to change web broadcasting compression. Select Override 
default compression settings and adjust the Lossless and Lossy settings. 
 

Figure 19 Sharing tab 

 
 
 

Lossless compression Compresses the images that are streamed without reducing 
image quality. Increasing lossless compression may use  
more of the video capture workstation’s CPU resources.  
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Lossy compression Compresses the images that are streamed  by reducing 

image quality. Lossy compression is not as CPU intensive 
as lossless compression.  

 

10 Configuring SDI2USB 3.0 from the Control 
Panel 

 
Your SDI2USB 3.0 can be configured from the Control Panel using the Epiphan frame 
grabber icon. Here you can verify the device’s serial number, type and status as well 
as setup configuration parameters. 
 
To edit the configuration of the device: 

1. From the Start menu, choose Control Panel. The Windows Control Panel 
window opens with a list of settings. 

2. Click Epiphan Frame Grabbers from the list; the following window opens. 
Figure 20 Frame grabber configuration 

 
 

3. Perform one of the following: 
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a) Click the Default Configuration button to make changes to the 

default configuration; or 
b) Click the Configure Device button to make changes to the normal 

configuration. 
The Edit Default Configuration window opens. It is similar to the Tools > 
Options > Configure command in the Epiphan Capture Tool.  

Figure 21 Edit Default Configuration window 

 
 

4. Edit the parameters. 
5. Click OK; the Edit Configuration window closes and the Epiphan Frame 

Grabber Configuration window reappears.  
6. Perform one of the following: 
7. Click the Default Configuration button to make changes to the default 

configuration; or 
8. Click the Configure Device button to make changes to the normal 

configuration. 
 

9. Select the Use default configuration parameter radio button to activate 
settings. 

10. Click Close. 
To edit device-specific configuration: 
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1. Click the Configure Device… button. It is similar to the Tools > Options > 

Configure command in the Epiphan Capture Tool.  
2. Edit parameters. 
3. Click OK and select the Maintain device-specific configuration radio button to 

activate settings.  
4. Click Close. 

 

11 Mac OS X SDI2USB 3.0 Video Capture 
Application 

This chapter describes the functions and features of the video capture application 
(Epiphan Capture Tool) for Mac OS X. You can use the Mac OS X version of the video 
capture application to configure your SDI2USB 3.0 and to record video captured by 
the SDI2USB 3.0. 
This chapter assumes that SDI2USB 3.0 has been properly installed. Please refer to 
the section: Connecting SDI2USB 3.0. To start using this chapter you should have:  

- Selected a video capture workstation running Mac OS X with installed 
SDI2USB 3.0.  

- A connected video source. 

11.1 Starting the Mac OS X Video Capture Application 

Start Epiphan’s video capture application as you would start any other application 
installed on the video capture workstation.  

As the application starts the message Capture Device not Found appears on the video 
capture application window. Follow the steps below: 

1. Select Open Network Grabber from the File menu. 
2. Select the arrow beside the Network Address box to open the list of 

networked devices. 
3. Select a device and select connect. 
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The following messages may appear in the capture window.  

• Detecting Video Mode as the video capture application starts up and 
attempts to connect with the frame grabber. 

• Tuning Capture Parameters if the video capture application finds the frame 
grabber and begins synchronizing and tuning capture settings and image 
adjustments  

• No Signal Detected if the video capture application cannot connect to the 
frame grabber or if the frame grabber is not connected to an active video 
source. 

Figure 22 Mac OS X toolbar 

 
 

If the video capture application successfully connects to and synchronizes with the 
frame grabber, the video capture application window begins displaying captured 
images. 

Title Bar Displays the Epiphan product name, screen resolution and refresh 
rate of the video source. 

Toolbar  Use the icons on the toolbar to save, copy or print the currently 
captured image, to record video, override image adjustments, 
select devices for connection or to show information about the 
device. 
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11.2 Menus 
This section describes the commands available from the video capture application 
menus for Mac OS X. 

11.2.1 File Menu  

Use the File menu commands to save the current image, print the current image, open 
new capture windows and start a recording.  Also included are the commands to 
connect to other frame grabbers on the network and disconnect from any available 
frame grabber. 

New Capture Window Opens another capture window. The window opens 
displaying the same image as the original window. You 
can open a different device in each capture window. 
Having a large number of Capture Windows open 
simultaneously can eventually slow performance on the 
video capture workstation. 

Open Network Grabber Connect to a SDI2USB 3.0 device on the network. 

Recent Network Grabbers Select from the list of recently opened frame grabber 
devices. 

Disconnect Network 
Grabber 

Disconnect the SDI2USB 3.0 device on the network. 
The device serial number will be shown next to the 
Disconnect menu item. If you have multiple capture 
windows open, make sure you select the capture 
window containing the device from which you want to 
disconnect. 

Record Movie Record captured video in a file. 

Save Image Save a snapshot of the current image to a file on the 
video capture workstation. Select a name and a location 
for the file and select a file format. You can save the 
snapshot as a bitmap (*.bmp), portable network 
graphics (*.png), JPEG (*.jpg) file, or tiff (*.tiff) file. 

Page Setup Configure the printer settings used when you select the 
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Print command or the Print toolbar button. 

Print Send a snapshot of the current image to the configured 
printer. 

11.2.2 Edit Menu  

From the Edit menu you can copy a snapshot of the current image. 

Copy Copy a snapshot of the current image to the video 
capture workstation clipboard.  

11.2.3 View Menu 

Use the commands on the View menu to control what information is displayed in the 
SDI2USB 3.0 user interface window.  

Show Device Information View the information about hardware 
type, location, serial number, video mode, 
and frame rate. 

Hide Device Information Hide the information about hardware 
type, location, serial number, video mode, 
and frame rate. 

Adjustment Controls Display the Adjustments tab (refer to 
Configure Device for details. 

Enter Full Screen Enter full screen mode 
 

11.2.4 Tools Menu 

Use the Tools menu to customize basic SDI2USB 3.0 user interface operating 
settings. 
 
Show VGA Mode Information View low-level VGA mode information 

Upload EDID to Device Use this command to upload an extended 
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display identification data (EDID) file to 
your device.  

Extended display identification data 
(EDID) is a data structure provided by a 
digital display to describe its capabilities 
to a video source. It is what enables a 
modern personal computer to know what 
kinds of monitors are connected to it. 
EDID is defined by a standard published 
by the Video Electronics Standards 
Association (VESA).  

Read EDID from Device Use this command to read an extended 
display identification data (EDID) file from 
the device. 

 

11.2.5 Window Menu 

Minimize Minimize the window. 

Zoom Zoom in on your screen. 

Bring all to Front Brings all of the windows of the current 
application to the front. 

11.2.6 Help Menu 

Search Search SDI2USB 3.0 Help 
 

11.3 Toolbar  

Use the toolbar to save, copy, print the current captured image, override image 
adjustments, or show information about the device.  
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11.3.1 Save 

Use this button ( ) to save a copy of the current image.  The following 
information will be requested when this toolbar icon is clicked.  
 
Save As Enter the file name for saving data. 

Where Enter the path where the file is saved. 

Format Select the format for the recorded file. 
 

11.3.2 Copy 

Use this button (  ) to copy the snapshot of the image to the workstation’s 
clipboard. 

11.3.3 Print 

Use this button (  ) to specify printing settings and print the image. 

11.3.4 Record 

Click this button (  ) to start the recording of a captured video. 

11.3.5 Adjust 

This button (  ) allows configuring horizontal/vertical shift to offset the captured 
image position. Select the checkboxes to adjust shifting automatically. Please refer to 
the Configure Device section for details. 

 
59 SDI2USB 3.0  User Guide 
 



Setting QuickTime Options for Recording Videos  
 

 

11.3.6 Info 

Click this button (  ) to display information about the frame grabber, its location, 
serial number and image characteristics. 

11.3.7 Devices 

Click this button (  ) to display all frame grabber devices that are currently 
available on the network. 

 

12 Setting QuickTime Options for Recording 
Videos 

Before recording videos, saving or printing images, you should configure the Epiphan 
QuickTime integration options by opening System Preferences, selecting Epiphan 
under Other, and configuring the QuickTime settings.  

You can also select About to view information about the current software and driver 
versions.  

 

12.1 To add or remove a network device  
 

1. To add a device, select the plus sign at the bottom left of the window. 
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2. Enter the IP Address of the device you want to add or click on the triangle 

beside the Network Address box and select the device from the list of 
networked devices. 

3. Select Connect. 
4. To remove a device select the device and select the minus sign. 

Figure 23 QuickTime settings 

 
 
Configure the following QuickTime recording options: 

Video resolution Select a video resolution option:  
Actual: The actual resolution of the video source as 
reported to QuickTime. No scaling is performed. If, 
at any point during a recording session, no signal 
is detected an error will occur that could interrupt 
the recording session.  
Default: If a video signal is not detected, the default 
resolution is reported and the video remains blank 
until a signal is detected. If the default resolution 
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does not match the actual resolution, images are 
resized to the default resolution.  
Fixed: The same resolution is reported to 
QuickTime, regardless of the actual resolution of 
the image and whether or not a video signal is 
present. All images are scaled to the fixed 
resolution.  
For Default or Fixed resolution, you can select the 
resolution to use.  
 

Scaling Select a Scaling Algorithm. When Video Resolution 

is set to Default or Fixed, you can move the slider 

to select a scaling algorithm from a set of 

algorithms that range from Lowest quality and Best 

speed to Best quality and Lowest speed. You can 

choose from:  
• Nearest pixel 
• Fast bilinear 
• Weighted average 
• Bilinear 
• Luma bicubic, chromabilinear 
• Bicubic 
• Lanczos 
• Natural bicubic spline 
• Sinc  

Default Image Format Select a Default Image Format. The Default Image 

Format will only be used if the QuickTime 

compatible application doesn’t specifically request 

an image format. 

Default Frame Rate Usually you can set the frame rate in the 
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QuickTime-compatible video recording application. 

If you cannot set the frame rate in the application, 

set the default frame rate that the Epiphan device 

driver sends to QuickTime. This default frame rate 

is only used if the application does not explicitly set 

the frame rate. 

Network Devices Add or remove Epiphan devices connected to the 

network. The Display shows the serial number, IP 

address and status (screen resolution and refresh 

rate of the video source) of each device. To add 

devices select the plus sign. To delete devices, 

select the minus sign. 

 

13 Web Broadcasting 

You can use the information in this chapter to share or stream the images captured by 
your SDI2USB 3.0 over the Internet. Note that web broadcasting is available only on 
video capture workstations running Windows. 

To stream captured images over the Internet, the video capture application sends 
captured images to an Epiphan web broadcasting portal. Each web broadcasting 
session is labelled with the serial number of the SDI2USB 3.0 that is capturing the 
images. The card’s serial number appears on the video capture application title bar.  

Web broadcasting sends the currently captured images or video only. You cannot 
stream saved recordings and the SDI2USB 3.0 web broadcasting feature does not 
include sound, even when audio and video is captured for SDI sources.  

Note: The web broadcasting feature included with the Epiphan video capture 
application is intended for demonstration only and has a 10-hour time limit.  
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It is important to note that the images streamed over the Internet are not secure. 
Potentially anyone can view the web stream if they know the correct URL. The web 
broadcasting feature included with the Epiphan video capture application provides 
basic features and functionality. For a richer web broadcasting feature set, refer to 
Epiphan’s broadcasting products. 

13.1 To set the display format for web broadcasting  

1. Open the SDI2USB 3.0 capture tool application on a video capture 
workstation running Windows. 

2. From the Tools menu select Options. 
3. Select the Display tab. 
4. Set Display Format to RGB 24 bits per pixel. 
5. Optionally limit the frame rate to reduce the number of images sent over the 

Internet and to reduce bandwidth usage. Depending on your requirements it 
may not be necessary to change any other display settings. Refer to section, 
Configuring Display Options for all available display settings. 

6. Select OK to save your changes. 

13.2 Start a web broadcast session  

All that is required to stream your video to the web is a video capture workstation 
connected to the Internet. The video capture workstation can be connected directly to 
the Internet or to a LAN that is connected to the Internet.  

Before streaming your video to the  Internet you need to set the display format to 24 
bits per pixel, refer to the previous section. 

To start a web broadcast: 

1. Connect the Epiphan frame grabber to the video source that you want to 
stream and to the video capture workstation. 

2. Launch the Epiphan capture tool. 
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3. Select Web Broadcasting from the Tools menu or from the toolbar select 

. 

The Start web broadcasting dialog appears. 

Figure 24 Web broadcasting 

 
 

13.3 Viewing a web broadcasting session  
You can view a web broadcasting session from a web browser running under 
Windows 2000, XP, Vista,  7 and 8 versions. The following browsers are now 
supported: Internet Explorer, Firefox, Opera, Chrome, and Safari. Mobile browsers are 
also supported if the mobile device is compatible with Java SE. The workstation and 
web browser should be running the most recent version of the Java plug-in. You can 
download the latest plugin from http://www.java.com.  

To view a web broadcast: 

1. Open a web browser and browse to the required URL, for example: 
http://www.vga2web.com/D2P00000.  This URL is supplied by the vg2web 
application and can be advertised to potential viewers of the broadcast. 
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A second web browser window appears displaying the message Applet is 
loading. Please wait… The broadcasted image should appear within 10 to 20 
seconds.  

The first web browser window in which the web broadcast URL address was 
entered, displays a message indicating that the web presentation has been 
opened in a new window. You can also use the first window to refresh the 
broadcast or re-open the broadcast window if it is accidentally closed.  

13.4  Changing web broadcasting compression and 
performance  

Normally you should not need to change the default web broadcasting compression 
settings. The default settings reduce the amount of Internet bandwidth used for web 
broadcasting by applying a combination of lossless and lossy compression to the 
images being broadcasted.  

To change the web broadcasting compression, from the Tools menu of the SDI2USB 
3.0 capture tool select Options and then select Sharing. Select Override default 
compression settings and adjust the Lossless and Lossy settings.  

 

13.5 Troubleshooting web broadcasting performance  

Here are three typical reasons for adjusting web broadcasting compression:  

• If you have a slow Internet connection or if viewers of the web broadcasts 
notice delays you can increase lossless or lossy compression to reduce 
Internet bandwidth usage.  

• If viewers of the web broadcast notice poor image quality you can reduce the 
amount of lossy compression.  
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• If the video capture workstation CPU usage is too high during web 

broadcasts or if viewers of the web broadcasts notice delays and you have 
determined that the delays are not caused by low Internet bandwidth. The 
delays could be caused by high CPU usage on the video capture workstation 
resulting in the video capture workstation not being able to process all image 
data. Lossless compression increases CPU usage, so you can reduce CPU 
usage during web broadcasting by reducing lossless compression. 

Note: You cannot change web broadcasting compression during a web broadcast. 
You must stop the broadcast, adjust the settings and then start the broadcast again.  

Changes made to default web broadcast compression settings are only visible to 
viewers of the web broadcast. Changing these settings does not change how the 
video capture application displays, records, or prints captured images.  

 

14 Advanced Topics 
 

14.1 Windows command line options 
You can use the following command line options to control how the Windows video 
capture application starts up. You can add as many command line options as you 
want in any order. All command line options must start with two dashes. Separate 
command line options with spaces.  
 

--borderless  Start the video capture application in image only mode. 
You can press Esc to exit from image only mode. 

--sn <sn> To specify which frame grabber to use if more than one 
frame grabber is connected to the PC. Similar to the 
Capture menu Select Device command.  
<sn> is the serial number of the frame grabber. 

--hs <#> Set the horizontal shift*. 
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--vs <#> Set the vertical shift*.  

--phase <#> Set the sampling Phase*. The range is 0 to 31. 

--pll <#> Set the PLL adjustment*. 

--offset <#> Set the offset (brightness)*. The range is 0 to 63. 

--gain <#> Set the gain (contrast)*. The range is 0 to 255. 

--topmost To keep the video capture application window on top. 

--fullscreen Start the video capture application in full screen mode. 

“*” – Refer to the Configure device section for more details. 

 
 

14.1.1 Creating a Windows Shortcut that Uses Command Line Options 

You can use video capture application command line options by creating a Windows 
shortcut to the video capture application executable file and editing the shortcut to add 
command line options. In the following procedure, the video capture application 
executable file v2ugui2.exe has been installed in the folder C:\Program Files\Epiphan: 
 
1. Open Windows Explorer and navigate the following path: 

C:\Program Files\Epiphan 
2. Right click on the file v2ugui2.exe and select Create Shortcut. Windows creates a 

shortcut file that, depending on your Windows settings, may be named “Shortcut 
to v2ugui2.exe.lnk”. The “.lnk” may not appear if Windows does not display file 
extensions. You can change the name of this file and copy it to another location if 
required. Don’t change the file extension. 

3. Right click on the shortcut file and select Properties. 
4. Edit the Target field and add command line options after the closing quote. For 

example, to add the --topmost command line option: 
"C:\Program Files\Epiphan\v2ugui2.exe" –topmost 
For example, to add --topmost and --borderless, set the horizontal shift to -67, 
and the vertical shift to 10: 
"C:\Program Files\Epiphan\v2ugui2.exe" –topmost --borderless --hs -67 --vs 10 

5. Select OK to save your changes to the shortcut. 
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6. Double-click on the shortcut to start the video capture application with the 

command line options.  
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16 Software and Documentation License 
 
ATTENTION:  THE SOFTWARE AND DOCUMENTATION PROVIDED UNDER THIS 
AGREEMENT ARE BEING LICENSED TO YOU BY EPIPHAN SYSTEMS INC. (“LICENSOR”) 
AND ARE NOT BEING SOLD.  THIS AGREEMENT CONTAINS LIMITATIONS ON 
REPRESENTATIONS, WARRANTIES, CONDITIONS, REMEDIES, AND LIABILITIES THAT 
ARE APPLICABLE TO THE SOFTWARE AND DOCUMENTATION. 
 

Epiphan Systems Inc. Software License 
 
IMPORTANT:  BEFORE DOWNLOADING, INSTALLING, OR USING THE SOFTWARE AND 
DOCUMENTATION, PLEASE CAREFULLY READ THIS AGREEMENT WHICH CONTAINS THE TERMS AND 
CONDITIONS UNDER WHICH YOU ARE ACQUIRING A LICENSE TO USE THE SOFTWARE AND 
DOCUMENTATION. IF YOU DO NOT ACCEPT THE TERMS AND CONDITIONS OF THIS AGREEMENT PLEASE 
DO NOT DOWNLOAD, INSTALL, OR USE THE SOFTWARE AND DOCUMENTATION AND PROMPTLY 
RETURN OR DESTROY THE SOFTWARE AND DOCUMENTATION. IF YOU DOWNLOAD, INSTALL, OR USE 
THE SOFTWARE AND/OR DOCUMENTATION, YOU WILL HAVE ACCEPTED AND AGREED TO THESE TERMS 
AND CONDITIONS. THE SOFTWARE AND DOCUMENTATION ARE ALSO PROTECTED BY COPYRIGHT LAWS 
AND INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER INTELLECTUAL PROPERTY LAWS. IF 
YOU ARE AN AGENT OR EMPLOYEE OF AN ENTITY, YOU REPRESENT AND WARRANT THAT (I) THE 
INDIVIDUAL ACCEPTING THIS AGREEMENT IS DULY AUTHORIZED TO ACCEPT THIS AGREEMENT ON 
SUCH ENTITY’S BEHALF AND TO BIND SUCH ENTITY, AND (II) SUCH ENTITY HAS FULL POWER, 
CORPORATE OR OTHERWISE, TO ENTER INTO THIS AGREEMENT AND PERFORM ITS OBLIGATIONS 
UNDER THIS AGREEMENT. 
 
1. Definitions:  In this Agreement: 
 
“Agreement” means this Epiphan Software License; 
 
“Documentation” means the technical publications delivered to You with the Software relating to the 
installation and operation of the Software, such as reference, user, installation and technical guides and 
release notes; 
 
“Epiphan” means Epiphan Systems Inc.; 

“Software” means the Licensor binary and/or bytecode software programs that (i) are made available to 
You for download after acceptance of this Agreement, (ii) are packaged with this Agreement, or (iii) pre-
installed on Epiphan products, or (iv) embed this Agreement in their installer(s) and which are installed 
after acceptance of this Agreement, and which binary and/or bytecode software programs include any 
Documentation; and 
 
“You” or “Your” means the individual acquiring the Software license or any entity on whose behalf such 
individual is acting. In the case of an entity, "You" includes any entity that by majority voting interest 
controls, is controlled by, or is under common control with You. 
 
2. Grant of Software License: Subject to the terms and conditions of this Agreement, Licensor grants You 
a non-exclusive, non-transferable, non-sub licensable, internal license to use a reasonable number of 
copies of the Software.  All copies of the Software made by You shall include all trademarks, copyright 
notices, restricted rights legends, proprietary markings and the like exactly as they appear on the copy of 
the Software originally provided to You.  No other rights in the Software or Documentation are granted to 
You. 
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3. Open Source Software: Binary, byte code and source code versions of certain open source software 
packages may be embedded in or distributed with the Software (“Open Source Software”).  If a separate 
license agreement for an item of open source software is: delivered to You with the Software; included in 
the download package for the Software; referenced in any material (including the Documentation) that is 
included in the download or distribution package for the Software; or listed at 
www.epiphan.com/opensource, then such open source software shall be Open Source Software and such 
separate license agreement shall govern Your use of that item or version of such open source software.  
The Open Source Software may include free software (i.e. software licensed under the GNU Lesser 
General Public License or other free software licenses) for which the applicable free software license may 
also require that the source code for such free software be made available to those receiving only 
executable versions of such free software.  If the source code for any free software distributed with the 
Software is not provided with the Software, then upon request, within a three (3) year period from the 
original receipt of such Open Source Software from Licensor, for a fee that shall not exceed Licensor's 
costs associated with the shipping of the source code for such free software, Licensor will provide a copy 
of the source code for such free software to You.   
 
4. Restrictions: The terms set forth in this Section 4 shall constitute conditions to the licenses granted in 
Section 2.  You shall not reverse engineer, disassemble, reverse translate, decompile or in any other 
manner decode the Software except to the extent the Software is distributed with any Open Source 
Software that prohibits the imposition of such a restriction or to the extent the foregoing restriction is 
expressly prohibited by applicable law notwithstanding a contractual obligation to the contrary.  You 
acknowledge and agree that no rights in respect to the source code of the Software are granted to You.  
You acknowledge and agree that the rights in respect to use of the Software and Documentation are 
granted only for use in conjunction with Epiphan hardware. You shall not distribute, lease, rent, grant a 
security interest in, assign, or otherwise transfer the Software except as expressly provided in this 
Agreement. You shall not modify or create any derivatives works of the Software or merge all or any part 
of the Software with another program.  You shall not use the Software or make the Software available to 
any third parties as part of any service bureau, time sharing service, application service provider offering, 
software-as-a-service offering or any other managed service offering.  You shall not disclose any 
performance, benchmarking, or feature-related information about the Software. You further agree not to 
disclose, transfer or otherwise provide to any third party any portion of the Software, except as expressly 
permitted herein. 
 
5. Disclaimer of Warranties:  Licensor does not make any representations or provide any warranties or 
conditions in respect to the Software.  EXCEPT FOR ANY WARRANTIES THAT MAY BE PROVIDED IN ANY 
COMMERCIAL AGREEMENT BETWEEN YOU AND LICENSOR, THE SOFTWARE AND DOCUMENTATION 
ARE PROVIDED “AS IS”, WITHOUT ANY REPRESENTATIONS, CONDITIONS, OR WARRANTIES OF ANY 
KIND. WITHOUT LIMITATION, LICENSOR AND ITS LICENSORS, SUPPLIERS, SUBCONTRACTORS AND 
DISTRIBUTORS DISCLAIM ANY EXPRESS OR IMPLIED REPRESENTATIONS, CONDITIONS, AND/OR 
WARRANTIES OF MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, DURABILITY, 
TITLE, SATISFACTORY QUALITY, OR FITNESS FOR A PARTICULAR PURPOSE WHETHER ARISING BY 
STATUTE, COURSE OF DEALING, USAGE OF TRADE, OR OTHERWISE.  EXCEPT AS OTHERWISE EXPRESSLY 
PROVIDED IN ANY COMMERCIAL AGREEMENT, THE ENTIRE RISK OF THE USE OF THE SOFTWARE AND 
DOCUMENTATION SHALL BE BORNE BY YOU.  EXCEPT AS OTHERWISE EXPRESSLY PROVIDED IN ANY 
COMMERCIAL AGREEMENT, NEITHER LICENSOR NOR ANY OF ITS LICENSORS, SUPPLIERS, 
SUBCONTRACTORS AND/OR DISTRIBUTORS MAKE ANY REPRESENTATIONS OR PROVIDE ANY 
CONDITIONS AND/OR WARRANTIES ABOUT THE SUITABILITY OF THE SOFTWARE AND/OR 
DOCUMENTATION OR ABOUT ANY INFORMATION AND/OR DATA THAT MAY BE PROCESSED BY OR 
MADE AVAILABLE USING THE SOFTWARE. 
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6. LIMITATION OF LIABILITY:  NEITHER LICENSOR NOR ANY OF ITS LICENSORS, SUPPLIERS, 
SUBCONTRACTORS AND/OR DISTRIBUTORS SHALL HAVE ANY LIABILITY TO YOU OR ANY OTHER 
PERSON OR ENTITY FOR ANY DAMAGES ARISING FROM THIS AGREEMENT, RELATING TO THE 
SOFTWARE OR DOCUMENTATION, OR RELATING TO ANY SERVICES PROVIDED TO YOU BY LICENSOR 
(INCLUDING ITS LICENSORS, SUPPLIERS, SUBCONTRACTORS AND/OR DISTRIBUTORS) IN RELATION TO 
THE SOFTWARE AND/OR DOCUMENTATION FOR ANY INDIRECT, RELIANCE, INCIDENTAL, SPECIAL, 
PUNITIVE, EXEMPLARY OR CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT LIMITED TO, LOSS OF 
REVENUE OR PROFIT, LOSS OF OR DAMAGE TO DATA, BUSINESS INTERUPTION, LOSS OF DATA, 
REPLACEMENT OR RECOVERY COSTS, OR OTHER COMMERCIAL OR ECONOMIC LOSS, WHETHER ARISING 
FROM CONTRACT, EQUITY, TORT (INCLUDING NEGLIGENCE OR STRICT LIABILITY) OR ANY OTHER 
THEORY OF LIABILITY, EVEN IF LICENSOR (INCLUDING ITS LICENSORS, SUPPLIERS, SUBCONTRACTORS 
AND DISTRIBUTORS) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE 
FORESEEABLE.  THE LIMITATIONS IN THIS SECTION SHALL APPLY WHETHER OR NOT THE ALLEGED 
BREACH OR DEFAULT IS A BREACH OF A FUNDAMENTAL CONDITION OR TERM OR FUNDAMENTAL 
BREACH. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THESE LIMITATIONS MAY NOT APPLY TO YOU. IN NO 
EVENT SHALL THE TOTAL CUMULATIVE LIABILITY OF LICENSOR (INCLUDING ITS LICENSORS, SUPPLIERS, 
SUBCONTRACTORS AND DISTRIBUTORS) TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY 
DAMAGES ARISING FROM THIS AGREEMENT, RELATING TO THE SOFTWARE, DOCUMENTATION 
AND/OR RELATING TO ANY SERVICES PROVIDED TO YOU BY LICENSOR (INCLUDING ITS LICENSORS, 
SUPPLIERS, SUBCONTRACTORS AND DISTRIBUTORS) IN RELATION TO THE SOFTWARE AND/OR 
DOCUMENTATION, EXCEED THE LICENSE FEES PAID BY YOU FOR THE SOFTWARE. 
 
THE DISCLAIMER OF REPRESENTATIONS, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY 
CONSTITUTE AN ESSENTIAL PART OF THIS AGREEMENT. YOU ACKNOWLEDGE THAT BUT FOR THE 
DISCLAIMER OF REPRESENTATIONS, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY, 
NEITHER LICENSOR NOR ANY OF ITS LICENSORS OR SUPPLIERS WOULD GRANT THE RIGHTS GRANTED IN 
THIS AGREEMENT. 
 
7. Term and Termination:  This Agreement shall continue for as long as You use the Software, however, it 
may be terminated sooner as provided in this Section 7.  You may terminate this Agreement by 
destroying all copies of the Software and Documentation under Your control and providing certification of 
such destruction to Licensor or by returning the Software to Licensor.  Licensor may terminate this 
Agreement immediately by providing You with written notice if: (a) You are in material breach of any 
provision of this Agreement, which breach, if capable of being cured, is not cured within thirty (30) days 
after Licensor gives You written notice thereof; or (b) You have committed a non-curable material breach 
of this Agreement.  Upon termination You shall destroy all copies of the Software.  In addition to this 
Section, the Sections entitled Definitions, Disclaimer of Warranties, Limitation of Liability, Title, High-Risk 
Activities, Intellectual Property, and General shall continue in force even after any termination of this 
Agreement.  No termination of this Agreement will entitle You to a refund of any amounts paid by You to 
Licensor or affect any obligations You may have to pay any outstanding amounts owing to Licensor.  Upon 
any termination by Licensor, You shall destroy all copies of the Software and Documentation under Your 
control and certify such destruction to Licensor. 
 
8.  Support and Updates:  This Agreement does not grant You the right to any updates or enhancements 
of the Software or the right to receive any technical support for the Software. Such updates and other 
technical support services, if available, may be purchased separately from Licensor.  Use of any updates 
or enhancements to the Software provided pursuant to any technical support You may procure from 
Licensor shall be governed by the terms and conditions of this Agreement.  Licensor reserves the right at 
any time not to release or to discontinue the release of any Software and to alter prices, features, 
specifications, capabilities, functions, licensing terms, release dates, general availability or other 
characteristics of the Software. 
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9.  Title:  All right, title, and interest (including all intellectual property rights) in, to, and under the 
Software (including all copies thereof) shall remain with Licensor and its licensors. 
 
10. High-Risk Activities:  The Software is not fault-tolerant and is not designed, manufactured or 
intended for use in or in conjunction with on-line control equipment in hazardous environments requiring 
fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation systems, air traffic 
control, or direct life support machines. Licensor, its licensors, suppliers, subcontractors and distributors 
specifically disclaim any express or implied representations, warranties and/or conditions for such uses. 
 
11. U.S. Government End-Users:  The Software and Documentation are each a "commercial item" as that 
term is defined at FAR 2.101, consisting of "commercial computer software" and "commercial computer 
software documentation" as such terms are defined in FAR 12.212, and are provided to the U.S. 
Government only as commercial end items. Government end users acquire the rights set out in this 
Agreement for the Software and Documentation consistent with: (i) for acquisition by or on behalf of 
civilian agencies, the terms set forth in FAR12.212; or (ii) for acquisition by or on behalf of units of the 
Department of Defense, the terms set forth in DFARS 227.7202. Use of the Software and Documentation 
is further restricted by the terms and conditions of this Agreement.  For the purposes of any applicable 
government use, the Software and Documentation were developed exclusively at private expense, and 
are trade secrets of Epiphan Systems Inc. for the purpose of any Freedom of Information legislation or 
any other disclosure statute, regulation or provision. 
 
12. Export Restrictions:  The Software, Documentation and related information are subject to export and 
import restrictions. By downloading, installing, or using the Software, Documentation and/or related 
information, You are representing and warranting that You are not located in, are not under the control 
of, and are not a national or resident of any country to which the export of the Software, Documentation 
and/or related information would be prohibited by the laws and/or regulations of Canada or the United 
States. You are also representing and warranting that You are not an individual to whom the export of the 
Software, Documentation or related information would be prohibited by the laws and/or regulations of 
Canada or the United States. You shall comply with the export laws and regulations of Canada and the 
United States that are applicable to the Software, Documentation and related information and You shall 
also comply with any local laws and/or regulations in Your jurisdiction that may impact Your right to 
export, import, or use the Software, Documentation or related information, and You represent and 
warrant that You have complied with any such applicable laws and/or regulations. The Software, 
Documentation and related information shall not be used for any purposes prohibited by export laws 
and/or regulations, including, without limitation, nuclear, chemical, or biological weapons proliferation. 
You shall be responsible for procuring all required permissions for any subsequent export, import, or use 
of the Software, Documentation or related information. 
 
13. Intellectual Property:  Epiphan is a trademark or a registered trademark of Epiphan Systems Inc. in 
certain countries.  All Licensor product names and logos are trademarks or registered trademarks of 
Epiphan Systems Inc. in certain countries. All other company and product names and logos are 
trademarks or registered trademarks of their respective owners in certain countries.  You shall not 
disclose, transfer or otherwise provide to any third party any portion of the Software, except as expressly 
permitted in this Agreement. 
 
14. General:  This Agreement is the entire agreement between You and Licensor in respect to the 
Software, superseding any other agreements or discussions, oral or written. The terms and conditions of 
this Agreement shall prevail over any pre-printed terms on any quotes, orders, purchase orders, or 
purchase order acknowledgements, and shall prevail over any other communications between the parties 
in relation to the Software. You may not assign this Agreement whether voluntarily, by operation of law, 
or otherwise without Licensor’s prior written consent. Licensor may assign this Agreement at any time 

 
74 SDI2USB 3.0  User Guide 
 



Software and Documentation License  
without notice. The failure of a party to claim a breach of any term of this Agreement shall not constitute 
a waiver of such breach or the right of such party to enforce any subsequent breach of such term. If any 
provision of this Agreement is held to be unenforceable or illegal, such decision shall not affect the 
validity or enforceability of such provisions under other circumstances or the remaining provisions of this 
Agreement and such remaining provisions shall be reformed only to the extent necessary to make them 
enforceable under such circumstances.  This Agreement shall be governed by the laws of the Province of 
Ontario and the laws of Canada applicable therein. No choice or conflict of laws rules of any jurisdiction 
shall apply to this Agreement.  You shall only be entitled to bring any action or proceeding arising out of 
or relating to this Agreement, the Software, Documentation or any services provided in respect to the 
Software and/or Documentation in a court in Ottawa, Ontario, Canada, and You consent to the 
jurisdiction of such courts for any such action or proceeding. You waive all rights that You may have or 
that may hereafter arise to contest the jurisdiction of such courts for any action or proceeding brought by 
You. You hereby waive any right. You may have to request a jury trial with respect to any action brought 
by You in connection with this Agreement, the Software or any services provided in respect to the 
Software. The application of the United Nations Convention on Contracts for the International Sale of 
Goods to this Agreement is expressly excluded.  
 
August 26, 2014 
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Environmental Information  

The equipment that you bought has required the extraction and use of natural 
resources for its production. It may contain hazardous substances that could impact 
health and the environment.  
In order to avoid the dissemination of those substances in our environment and to 
diminish the pressure on the natural resources, we encourage you to use the 
appropriate take-back systems. Those systems will reuse or recycle most of the 
materials of your end life equipment in a sound way.  
The crossed-out wheeled bin symbol invites you to use those systems. If you need 
more information about collection, reuse and recycling systems, please contact your 
local or regional waste administration. You can also contact us for more information on 
the environmental performance of our products.  
 

FCC & CE Compliance Statement 
 
This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: 
(1) This device may not cause harmful interference 
(2) This device must accept any interference received, including interference that may 
cause undesired operation. 

Marking by the symbol indicates compliance of this device with EMC directive of 
the European Community and meets or exceeds the following technical standard.  

EN 55022 - Limits and Methods of Measurement of Radio Interference Characteristics 
of Information Technology Equipment. 
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Other Jurisdictional Issues  

Epiphan makes no representation that its products or information in this document or 
its web site is appropriate or available for use in your jurisdiction. Those who choose 
to access the Epiphan web site or use Epiphan products do so on their own initiative 
and are responsible for compliance with local laws, if and to the extent local laws are 
applicable.  
 

Submissions to Epiphan and Affiliated Servers  

Any information, including but not limited to remarks, suggestions, ideas, graphics, or 
other submissions, communicated to Epiphan through their Epiphan web site is the 
exclusive property of Epiphan. Epiphan is entitled to use any information submitted for 
any purpose, without restriction (except as stated in Epiphan's Privacy Statement) or 
compensation to the person sending the submission. The user acknowledges the 
originality of any submission communicated to Epiphan and accepts responsibility for 
its accuracy, appropriateness, and legality.  

 

Third Parties and Links to Third-Party Web Sites 

Mention of non-Epiphan Systems Inc. products or services on their website, or this 
document site is for informational purposes and does not constitute an endorsement 
or recommendation.  
 
This document may contain links to non-Epiphan web sites. These links are provided 
to you as a convenience, and Epiphan is not responsible for the content of any linked 
web site. Any outside web site accessed from the Epiphan web site is independent 
from Epiphan, and Epiphan has no control over the content of that web site. In 
addition, a link to any non-Epiphan web site does not imply that Epiphan endorses or 
accepts any responsibility for the content or use of such a web site.  
In no event shall any reference to any third party or third party product or service be 
construed as an approval or endorsement by Epiphan of that third party or of any 
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product or service provided by a third party.  
 

Miscellaneous 

It is the user's responsibility to ascertain whether any information downloaded from the 
Epiphan web site or other websites is free of viruses, worms, trojan horses, or other 
items of a potentially destructive nature.  
 

Enforcement of Terms and Conditions  

These Terms and Conditions for use of this document and the associated Epiphan 
Product are governed and interpreted pursuant to the laws of the province of Ontario, 
Canada, notwithstanding any principles of conflicts of law.  
 
All disputes arising out of or relating to these Terms and Conditions shall be finally 
resolved by arbitration conducted in the English language in Ottawa, Ontario, Canada 
under the commercial arbitration rules of the Canada. The parties shall appoint as sole 
arbitrator a retired judge who presided in the province of Ontario. The parties shall 
bear equally the cost of the arbitration (except that the prevailing party shall be entitled 
to an award of reasonable attorneys' fees incurred in connection with the arbitration in 
such an amount as may be determined by the arbitrator). All decisions of the arbitrator 
shall be final and binding on both parties and enforceable in any court of competent 
jurisdiction. Notwithstanding this, application may be made to any court for a judicial 
acceptance of the award or order of enforcement. Notwithstanding the foregoing, 
Epiphan shall be entitled to seek injunctive relief, security, or other equitable remedies 
from any court of competent jurisdiction.  
If any part of these terms is unlawful, void, or unenforceable, that part will be deemed 
severable and will not affect the validity and enforceability of the remaining provisions. 
Epiphan may, at its sole discretion and without notice, revise these terms at any time 
by updating this posting. 
 

Copyright © 2014 Epiphan Systems Inc.  
All Rights Reserved. 

UG102-01 
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